ZAPADOCESKA UNIVERZITA V PLZNI
FAKULTA APLIKOVANYCH VED
KATEDRA MATEMATIKY

BAKALARSKA PRACE

REKONSTRUKCE 3D TVARU MOVITEHO PREDMETU ZVOLENOU
TECHNIKOU

Plzen, 2016 Hana Kubickova



D00 g ATt e S A AN A O T M AN S AR AT LR, e el L

ZAPADOCESKA UNIVERZITA V PLZNI
Fakulta aplikovanych véd
Akademicky rok: 2015/2016

ZADANI BAKALARSKE PRACE

(PROJEKTU, UMELECKEHO DILA, UMELECKEHO VYKONU)

Jméno a piijmeni:
Osobni ¢islo:
Studijni program:
Studijni obor:

Nézev tématu:

Zadavajici katedra:

Hana KUBICKOVA
A12B0303P
B3602 Geomatika

Geomatika
Rekonstrukce 3D tvaru movitého pfedmétu zvolenou technikou

Katedra matematiky

Zidsady pro vypracovani:

1. ReSerse existujicich technik shéru dat ve 3D se zaméfenim na movité predméty.

o

Porovnani technik sbéru 3D dat bézné dostupnym hardware se zvolenou technikou sbéru

dat pomoci geodeticky presného hardware.

3. Porovnani technik provedte vlastnim méfenim zvolenymi technikami a jejich vyhodno-

cenim.



Rozsah grafickych praci: dle potieby
Rozsah kvalifikacni prace: cca 20 stran
Forma zpracovani bakalarské prace: tisténa
Seznam odborné literatury:
e BEZDEK, L., BOBEK, K., BURSIK, D., JEDLICKA, K.: Metodika pro

elektronicky pasport zpfistupnéné pamatky, Narodni pamatkovy tustav,
ustfedni pracovisté, 2011, ISBN 978-80-87104-87-3

e PACINA, J., ORSULAK, T.: 3D modelovéni a virtudlni realita. Usti nad
Labem : Ing. Tomas Mikulenka, Usti nad Labem, 2012

e PAVELKA, K.: Fotogrammetrie, Zadpadoceska univerzita v Plzni, Fakulta
aplikovanych véd, Plzen, 2003, ISBN 80-7082-972-9

e PAVELKA, K., HODAC J.: Digitalni metody a laserové skenovéni, CVUT,
Praha, 2008, ISBN 978-80-01-03978-6

Vedouci bakalarské prace: Ing. Karel Jedlicka, PhD.

Katedra matematiky

Datum zadani bakalarské prace: 1. fijna 2015

Termin odevzdani bakalarské prace: 31. kvétna 2016

A
Vany D
L Y LS. g/
Doc. RNDr. Miroslav Lavicka, Ph.D. Prof. RNDr. Pavel Drabek, DrSc.
dékan vedouci katedry

V Plzni dne 1. fijna 2015



4

Prohlaseni

Prohlasuji, Ze jsem bakalafskou praci na téma "Rekonstrukce 3D tvaru movitého predmétu
zvolenou technikou" vypracovala samostatné a s pouzitim uvedené odborné literatury

a prament, jejichz uplny seznam je jeji soucasti.

V Plzni, dne 21.5. 2016

Hana Kubic¢kova



Podékovani

Na tomto misté bych rdda podékovala svému vedoucimu bakalarské prace Ing. Karlu
Jedlickovi, Ph.D. za cenné rady, vécné pripominky, trp€livost a ochotu, kterou mi
v prub¢hu zpracovani této bakalarské prace vénoval. Déle bych také chtéla podékovat své

rodin€ za plnou podporu v pritb¢hu studia.

V Plzni, dne 21.5. 2016

Hana Kubi¢kova



Abstrakt

Tato prace tesi rekonstrukci 3D tvaru movitého pfedmétu na zékladé sbéru dat dvéma
rozdilnymi technikami, jejichz hlavni rozdil spociva v cenové dostupnosti. Jsou jimi sbér
dat nemétickou kamerou mobilniho telefonu za vyuziti metody Structure from Motion,
tedy bézné dostupny hardware, a statické pozemni laserové skenovani, geodeticky presny
hardware. Cilem této prace je porovnat tyto techniky na zakladé zjisténi jejich vyhod
a nevyhod vyplyvajicich z vlastniho méfeni a zpracovani dat. Dal$im cilem je rovnéz
zjisténi presnosti téchto technik prostiednictvim vypocteni objemi vytvorenych 3D
modelll a naslednym porovnanim S analyticky vypoctenym objemem predmétu sbéru dat.
Pro zpracovani snimkl pofizenych neméfickou kamerou byl pouzit software Agisoft
PhotoScan a pro zpracovani mra¢na bodi pofizeného laserovym skenovanim software
Meshlab. Porovnani vyslednych 3D modelti nakonec neprobéhlo pouze na zakladé vypoctu
objemu vyslednych 3D modeld, ale také prostiednictvim povrchovych odchylek, které byly

zjistény softwarem CloudCompare.

Klicova slova: 3D model, 3D rekonstrukce, laserové skenovani, neméficka kamera,

Structure from Motion, Agisoft PhotoScan, Meshlab, CloudCompare



Abstract

This bachelor thesis deals with 3D reconstruction of movable object based on two different
techniques of data collection. The main difference between those techniques consist of the
afordability. Techniques are folowing, data collection with non-metric camera of cell
phone, thus commercialy available hardware, using Structure from Motion method
and static terrestrial laser scanning, surveying the precise hardware. The aim of this study
is to compare these techniques based on the establishment of their advantages
and disadvantages consequent from the measurement and data processing. Another goal is
to determine the accuracy of these techniques via calculating the volumes of 3D models
and subsequent comparison with analytically calculated volume of the subject data
collection. Software, which was used for processing images taken with the non-metric
camera is Agisoft PhotoScan and Meslab for point cloud processing acquired by laser
scanning. In the end comparison of the 3D models weren't only on the basis of calculating
the volume of the resulting 3D models, but also through the surface aberrations that were

detected by CloudCompare software.

Key words: 3D model, 3D reconstruction, laser scanning, non-metric camera, Structure
from Motion, Agisoft PhotoScan, Meshlab, CloudCompare
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Seznam pouzitych zkratek

BMP BitMaP image file

DXF Drawing Exchange Format

EXIF Exchangeable Image File
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3DS 3D Studio file format



Uvod

V dnesni dobé roste spolecné s technologickym rozvojem pocitacové 3D grafiky zdjem
o tvorbu 3D modell, ktera mé& v praxi velmi Siroké uplatnéni. NejCastéji jde
o oblasti architektury, urbanismu a uzemniho plénovani, mediciny, strojirenstvi,
archeologie a v neposledni fad¢ také kulturniho dédictvi v ramci jeho zachovani a ochrany.
Pro ucely pamatkové dokumentace jsou vytvafeny 3D modely nemovitych pamatek,
ale také 3D modely pamatek movitych, mezi které patii napiiklad sochy nebo inventar

nalezici nemovité pamatce.

Dilezitou roli vSak hraje v oblasti pamatkové dokumentace cena, jednoduchost a rychlost
zpracovani. To vede k otdzce nizkondkladovych technik sbéru dat vyuzivajicich bézné
dostupny hardware, tedy nekalibrované fotoaparaty. Diky vyuziti autokalibrace
neméfickych kamer a vyvoji softwarti, které s autokalibraci pracuji, se klasické
fotogrammetrické metody staly mnohem dostupnéjS$i a automatizovanéjsi. Vyvoj nové
metody, kterd nese nazev Structure from Motion (SfM), vSak jesté posouva rekonstrukci
3D scény na vysSi uroven automatizace ve zpracovani a jednoduchosti pouziti oproti

klasické digitalni fotogrammetrii.

Cilem této prace je porovnat metodu SfM za pouziti bézné dostupného hardware
s metodou vyuzivajici geodeticky piesny hardware, laserovym skenovanim. Porovnéni
bude provedeno na zakladé vyhod a nevyhod vyplyvajicich z vlastniho méfeni
a nasledného zpracovani dat. DalSim cilem je zjiSténi pfesnosti vyslednych 3D modeld
vytvofenych na zdklad¢ takto ziskanych dat s analyticky vypoctenym objemem movitého

pfedmétu, ktery se stane predmétem sbéru dat.

Prvni kapitola bude slouzit k pfibliZzeni souc¢asného stavu teSeni rekonstrukce 3D tvaru
movitych predméti od samotného sbéru dat po zplsoby jejich zpracovani prostiednictvim
zvefejnénych ¢lanku a publikaci zabyvajicich se touto problematikou. Druhd kapitola bude
reSersi existujicich technik sbéru dat ve 3D, se kterou souvisi tfeti kapitola tykajici se
nemeétickych kamer. Dalsi kapitoly se jiz budou zabyvat praktickou ¢asti této prace,
a to postupy sbéru dat ve 3D zvolenymi technikami, tvorbou 3D modeli a naslednym

vyhodnocenim téchto metod.
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1 Soucasny stav reSeni rekonstrukce 3D tvaru movitého
predmétu

Cilem této kapitoly je shrnuti dnes pouzivanych metod pro rekonstrukci 3D tvaru,
a to od samotného zplusobu sbéru dat prostiednictvim pozemnich metod déalkového

prizkumu, az po jejich nésledné zpracovani a zhodnoceni jejich piesnosti. Zvlastni zietel

bude kladen zejména na ¢lanky zabyvajici se metodou Structure from Motion.

Dukazem toho, ze se zejména nizkonakladové metody rekonstrukce 3D tvaru staly
v poslednich letech velmi diskutovanym tématem po celém svété, je nespocet ¢lanki
zvefejnénych ve sbornicich z konferenci ISPRS (International Society for Photogrammetry
and Remote Sensing), organizace, kterd je zaméfend na rozvoj mezinarodni spoluprace
v oblasti fotogrammetrie a dalkového prizkumu Zemé, nebo publikaci vydanych

nizozemskym nakladatelstvim Elsevier, které vydava odbornou a Iékatskou literaturu.

V praci New Low-Cost 3D Scanning Techniques for Cultural Heritage Documentation
(Rezni¢ek & Pavelka, 2008) je feSena otizka vyhod nizkonakladového bezkontaktniho
sbéru dat pomoci 3D optického skeneru oproti financn€ velmi ndkladnym triangula¢nim
a laserovym skenerim pro ucely pamatkové dokumentace, kdy je jak uz bylo v Gvodu
feCeno vyzadovana nizka cena, jednoduchost a rychlost zpracovani dat, zejména pak pii
dokumentaci 3D tvaru soch. Cilem prace je popis zakladnich principti zpracovani takto
pofizenych dat, ke kterému diky znalosti pozic kamer dochazi metodou bundle adjustment,

a nasledna tvorba 3D modelu.

Dalsi ¢lanek, Multi-image 3D reconstruction data evaluation (Koutsoudis et al., 2012),
pojednéava o objektivnim zhodnoceni kvality 3D modelu nemovité pamatky, ktery vznikl
na zakladé potfizenych snimkii pozemni blizkou fotogrammetrii v kombinaci s metodou
UAV (Unmanned Aerial Vehicle, neboli bezpilotni 1étajici prostfedek), a vyhodnocenim
pouzitelnosti této metody v realném scénafi. Vlastni tvorba 3D modelu zde probiha
v komer¢nim softwaru PhotoScan Standard (Agisoft LLC), ktery pro rekonstrukci scény
a polohy kamer pracuje s jiz zminénym algoritmem Structure From Motion.
Tento algoritmus mimo jiné figuruje jako klicové slovo ve vice nez 600 referatech
publikovanych na ISPRS. Pro vyhodnoceni pfesnosti vysledného 3D modelu byla
provedena rekonstrukce 3D tvaru téze pamatky prostfednictvim dalsi metody sbéru dat,

a to pozemnim laserovym skenovanim. Takto vytvoiené modely byly nasledné porovnany
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v programu CloudCompare na zakladé povrchovych odchylek a méfenim vzdalenosti
na obou modelech, které byly nasledné porovnany se skute¢nymi vzdalenostmi ziskanymi
geodetickym zaméienim. Na zakladé pouzitého hardware a software vybaveni vysledky
studie prokazaly, ze 1ze dosahnout vysoce kvalitnich vysledkGi pfi pouziti obsahlé sady

snimku.

Automatizované zpracovani snimkud pro ucely tvorby 3D modell se stalo v posledni dobé
velmi z4dané a vedlo tak k velkému rozmachu ve vyvoji takto pracujicich softwartl. Clanek
Low-Cost and Open-Source Solutions for Automated Image Orientation - A Critical
Overview (Remondino et al., 2012) referuje o piesnosti 3D modeld vznikajicich
automatizovanym zpracovanim snimki na zakladé vystupti z nékolika softwarti, jimiz jsou
Agisoft PhotoScan, Apero, Bundler, Photosynth a VisualSfM. Pro porovnani ptesnosti
vystupl, bylo pouzito né¢kolik riznych datovych sad potizenych kalibrovanymi
i nekalibrovanymi kamerami piedstavujici nejen rozsahlé a ¢lenité scény, ale také znamé
geometrické tvary obsahujici pfesné kontrolni body a referenéni méfitko. Na zakladé
porovnavanych vysledkii byla metoda Structure from Motion, kterou vétSina z vySe
zminénych softwarti pouziva, shleddna v pfipadé¢ implementace pro rozsahlé a dlouhé
sekvence jako nespolehliva kvuli nestabilnimu uréeni prvka vnitini orientace. Presto vSak
bylo pii porovnavani odchylek objektovych soufadnic bod dosazeno piekvapivé dobrych

vysledkd, které jsou vysvétleny kompenzaci ve spravnosti uréeni prvktl vnéjsi orientace.

Z vyse uvedenych clanku je patrné, Ze testovani presnosti metody Structure from Motion je
realizovano zejména ve spojitosti s nemovitymi pamatkami. Samotné urceni piesnosti
probiha vzhledem k Cclenitému tvaru nemovitych pamadatek porovnadvanim omérnych,
povrchovych odchylek nebo pomoci kontrolnich bodii. Vhodnym vybérem movitého
predmétu o zndmém geometrickém tvaru docilime moZnosti zjiSténi presnosti této metody
v porovnani s technikou sbéru dat vyuzivajici geodeticky piesny hardware,
a to prostfednictvim urceni objemui vytvorenych 3D modeld a naslednym porovnanim
ziskanych vysledkl s analyticky vypoctenym objemem tohoto pfedmétu, z ¢ehoz vyplyva

jeden z cila prace.
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2 Techniky sbéru dat ve 3D se zamérenim na movité
predméty

Soucasti 3D modelovani je nejen proces, pii kterém dochazi k rekonstrukci 3D tvaru
objektu, ale také samotny sbér dat ve 3D. Tato bakalarska prace vyuziva pro sbér téchto
dat metod dalkového prizkumu. Dalkovy prizkum je podle (Lillesand & Kiefer, 2003)
definovan jako: " véda i umeni ziskavat uZitecné informace o objektech, plochach ci jinych
jevech prostrednictvim dat merenych na zarizeni, ktera s témito zkoumanymi objekty,
plochami ¢i jevy nejsou v primém kontaktu." Tyto metody vSak vzhledem k malému
meéfitku movitych predméti zuzujeme pouze na metody pozemni, kdy k ziskdvani dat

slouzi predevsim senzory zalozené na odrazu svétla. (Remondino, 2006)

Existuje nékolik zplisobld sbéru 3D dat, které mlzeme ziskat z rGznych zdroja
a za pouziti rozdilnych metod. Zakladni déleni téchto metod spociva v jejich rozdéleni
na metody méfické a nemétické. Métické metody jsou takové, pii kterych ziskdvame data
méfenim. Neméfickou metodou je mysleno vyuziti jiz existujicich neboli archivnich dat,

ktera mohou slouzit jako podklad pro nové méteni. (Hodac, 2002)

Podle (Hoda¢, 2002) lze meéfické metody dale délit na metody fotogrammetrické,
geodetické a laserové skenovani. Cilem této kapitoly je podrobnéji popsat zminéné
metody. Zvlastni zietel bude kladen pouze na techniky, které jsou vhodné pro sbér 3D dat

zamé&feny na movité predmeéty.

2.1 Fotogrammetrické metody

"Fotogrammetrie je méricka metoda umoznujici modelovani v 3D prostoru s vyuZitim

2D snimki." (Kasser & Egels, 2002)

"Fotogrammetrie je véda, zpiisob a technologie, ktera se zabyva ziskavanim dale
vyuzitelnych mereni, map, digitalniho modelu terénu a dalsich produkti, ktere Ize ziskat

z obrazového, nejcasteji fotografického zaznamu." (Pavelka, 2003)

Z vyse uvedenych definic fotogrammetrie plyne, zZe k zachyceni reality slouzi pofizeny
obraz, tedy snimek. Na snimcich lze z polohy bodad odvodit velikost, tvar
a umisténi predmétu v prostoru a urCit vzajemnou prostorovou polohu jednotlivych bodu.

Fotogrammetrické metody se tak fadi k bezkontaktnim metodam sbéru dat.
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Tyto snimky lze pofidit dvéma typy kamer, a to kamerami métickymi, u kterych zname
kalibra¢ni prvky (prvky vnitini orientace) kamery, nebo kamerami nemétickymi (naptiklad
digitalni fotoaparaty), u kterych tyto kalibra¢ni prvky nezname. Znalost kalibra¢nich prvki
hraje rozhodujici roli v celkové piesnosti fotogrammetrickych praci. (Hodac¢, 2002)
Vzhledem k tomu, Ze jednou z porovnavanych technik sbéru dat, kterymi se tato prace
zabyva, je pofizeni snimkll neméfickou kamerou, je jejich podrobnéj$§imu popisu

a zpusobu kalibrace vénovana kapitola 3 Nemérické kamery.

Fotogrammetrii d&lime’ podle po&tu vyhodnocovanych snimkéi na jednosnimkovou
a vicesnimkou. Pfi jednosnimkové fotogrammetrii vyhodnocujeme data ze samostatnych
mefickych snimkl, na kterych lze méfit pouze rovinné soufadnice. To znamena,
Ze vystupem jsou opét 2D soufadnice, a proto sama o sob¢ neni pro nase ucely ziskani 3D
dat vhodna. Vicesnimkova fotogrammetrie je zalozena na principu vyhodnocovani dvou
a vice vzajemn¢ piekryvajicich se snimkl. Z jednoho snimku uré¢ime 2D soufadnice bodl
a pridanim druhého snimku docilime ziskani tfetiho rozméru. Dilezitym ptedpokladem
pro vypocet 3D soufadnic pfedmétu je jeho zobrazeni na obou piekryvajicich se snimcich,

kde dochazi k vyhodnocovani snimkovych soutadnic tohoto predmétu.

K vicesnimkové fotogrammetrii fadime stereofotogrammetrii (podrobnéji v 2.1.1
Stereofotogrammetrie), ktera umoziuje vyhodnoceni 3D soufadnic na zaklade
stereoskopického vjemu, a prasekovou fotogrammetrii (podrobngji v kapitole 2.1.2
Prisekova fotogrammetrie), jejiz princip spo¢iva v protinani os zabéru snimkd pod
konvergentnim thlem. (Pavelka, 2003) Do skupiny vicesnimkové fotogrammetrie I1ze fadit
i metodu SfM (podrobné&ji v 2.1.3 Structure from Motion), kterou miZeme zjednodusené
charakterizovat jako kombinaci stereofotogrammetrie a prisekové fotogrammetrie.

(Simigek, 2014)

! Fotogrammetrii, lze délit mnoha dalimi zpiisoby, a to podle polohy stanoviska, ze kterého byl pofizen
snimek, na pozemni, leteckou a druzicovou. Dale pak podle zplsobu zpracovani snimkd, to znamena podle
zplsobu prevodu snimkovych soufadnic na prostorové soufadnice, na metody analogové, analytické a
digitalni. Dalsi metody fotogrammetrie ziskame jejim rozdélenim dle zpiisobu zdznamu vystupnich hodnot

fotogrammetrického vyhodnoceni snimkt na grafické a ¢iselné (numerické).
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2.1.1 Stereofotogrammetrie

Stereofotogrammetrie (dvousnimkova fotogrammetrie) je nejptresnéjsi fotogrammetrickou
metodou, kterd byla zavedena po&atkem 20. stoleti. Ve slovniku VUGTK je definovéna
takto: "Stereofotogrammetrie je cast fotogrammetrie, zabyvajici se zjiStovdnim
geometrickych vilastnosti, popripadé i polohy objektii z dvojice fotografickych merickych

snimkii na zaklade stereoskopického pozorovani.”

Nepochybn¢ velkou vyhodou stereofotogrammetrie je, ze umoziuje na zékladé
stereoskopického vjemu® vyhodnotit 3D soufadnice jak u bodd signalizovanych
tak 1 u bodi nesignalizovanych. Vstupni hodnoty pro vypocet 3D soufadnic ziskdme tak,
ze na levém snimku méfime snimkové soufadnice pozorovaného bodu a pravy snimek
slouzi k uréeni horizontalni paralaxy®, kterou zjistime vzdalenost pozorovaného bodu.
Podminkou vzniku stereoskopického vjemu je odstranéni vertikdlni paralaxy?,
z ¢ehoz vyplyva, ze pro zajisténi kvalitniho stereoskopického vjemu je nutné, aby byly osy
zabéru alespon ptiblizné rovnobézné. Pro kvalitni vyhodnoceni snimkii je dale tieba
dodrzet u pozemni stereofotogrammetrie vhodnou délku zékladny, ta zavisi na vzdalenosti
nejbliz§ich a nejvzdalengSich bodi, které budou z uvaZzované zakladny vyhodnoceny
s pozadovanou presnosti, a pfiblizné stejné vySky obou stanovisek, ze kterych jsou snimky

pofizovany.

Nevyhodou této metody je, ze pro vyhodnoceni obsahu je nutny specialni software

......

(Pavelka, 2003)

2 Stereoskopicky viem je zédkladem prostorového rozliSovani bodii. Vznikd v mozku prostiednictvim dvou
zdravych o¢i schopnych akomodace (zmeny zakiiveni) o¢ni Cocky a konvergence (stoCeni) ocnich os tak, aby
byl pozorovany bod zaostfeny a o¢ni osy se na ném protinaly.

® rozdil snimkovych soufadnic tého? bodu na levém a pravém snimku stereodvojice ve sméru
fotogrammetrické zakladny

* rozdil snimkovych soufadnic téhoZ bodu na levém a pravém snimku stereodvojice ve sméru kolmo

na fotogrammetrickou zakladnu.
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2.1.2 Priisekova fotogrammetrie

Prisekovd fotogrammetrie je jedna 2z nejstarSich fotogrammetrickych metod,
ktera umoznuje vyhodnoceni prostorovych soufadnic pfedmétu na zakladé prekrytu dvou
a vice meétickych snimki. Principem urceni prostorovych soutfadnic bodii pfedmétu je

vzajemna konvergence (sbihavost) os zabéru snimku (viz Obr. 2.1). (Pavelka, 2003)

Obr. 2.1 Schéma snimkovani u priisekové fotogrammetrie (Pavelka, 2003)

Pti pofizeni snimkii, je urCeni prostorovych soufadnic bodi objektu dano dvéma
nasledujicimi kroky, a to vypoétem prvki vnéjsi orientace, coz jsou udaje, které definuji
polohu projekéniho centra (soufadnice stfedu vstupni pupily objektivu) a sklony kamery
pro vSechny snimky definujici model. Soutfadnice polohy kamery vypocteme bud’
geodeticky (moZno jen u pozemni fotogrammetrie), nebo vypoctem pomoci vlicovacich
bodl. Sklony kamery jsou vypocteny pomoci vlicovacich bodii. Druhym krokem je
vypocet prostorové polohy podrobnych bodli prostorovym protindnim zpét. Vypocet
probiha podle pouzitého softwaru bud’ vicekrokové, nebo v jednom kroku pomoci metody

bundle adjustment, ktera vychazi z rovnic pro kolinearni transformaci. (Hoda¢, 2002)

K vyhodam priasekové fotogrammetrie nepochybné patii flexibilita jejiho pouziti
a jednoduchy vypocet prostorovych soufadnic podrobnych bodl predmétu. (Hodac, 2002)
Nevyhodou této metody je nutnost identifikace odpovidajicich si bodii na snimcich,
to znamena, ze jednotlivé body musi byt pfirozené nebo uméle signalizovany. (Pavelka,

2000)
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2.1.3 Structure from Motion (SfM)

Tato metoda vychazi z principu priusekové fotogrammetrie a je aplikovana v digitalnim
prostiedi s prvky pocitacového vidéni. (Pavelka et al., 2015) Pokud doslovné pielozime
anglicky nazev této metody, dostaneme vyraz "struktura z pohybu", a tim i hlavni podstatu
této metody. Tou je stejn€ jako u klasickych fotogrammetrickych metod odhadovani 3D
prostorovych soufadnic z dvourozmérnych piekryvajicich se snimkl pofizenych
z pohybujiciho se nosice. (Prispivatelé Wikipedie, 2016c) Klasické fotogrammetrické
metody ale pracuji s piibliznou polohou kamery nebo vlicovacimi body o znamych
soufadnicich za tu¢elem snazs$i rekonstrukce 3D scény. (Westoby et al., 2012)
Z hlediska moznosti pofizeni snimkll s rovnobéznymi i konvergentnimi osami zabéru,
kombinuje tato metoda vyhody prusekové fotogrammetrie a stereofotogrammetrie. Jedinou
podminkou pro potizené snimky je jejich co nejvétsi piekryv (viz Obr. 2.2) a dostate¢na

kvalita (vice v kapitole 4.2 Sber dat nemérickou kamerou za vyuziti metody SfM).

K rekonstrukci scény dochézi tak, ze jsou v sekvenci navazujicich snimkt vyhleddvany
geometrické struktury a jejich pohyb a vyskyt v ostatnich snimcich, zaroven dochazi
K uréeni polohy kamer, prvkt vnéj$i a vnitini orientace snimkt a nasledné ke korelaci
snimkt. Vysledkem je fidké mrac¢no bodi, které je dalSimi algoritmy doplnéno na husté

mracno bodu (Pacina et al., 2015).

i Feature of
: interest
Finish E < i =

Obr.2.2 Snimkovdni metodou Structure from Motion (Westoby et al., 2012)

Jednoduchost pouziti a vysokd mira automatizace této metody vedla k vyvoji né€kolika
softwarti pracujicich na jejim principu. Mezi volné dostupné softwary patii napiiklad
Microsoft Photosynth a Bundler. Se Structure from Motion pracuje taktéZ komercni
software PhotoScan od firmy Agisoft LLC (podrobnéji v kapitole 5.1 Pouzité programové

vybaveni), ktery je pro tvorbu 3D modelu z neméfickych snimki v této praci pouzit.
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2.2 Laserové skenovani

Laserové skenovani neboli LIDAR (Light Detection and Ranging) je velice
progresivni metoda bezkontaktniho sbéru velkého mnozstvi prostorovych soufadnic bodi
za kratkou dobu observace. Laserové skenovani se podle umisténi skeneru déli
na statické pozemni, mobilni pozemni a mobilni letecké. Vzhledem k ucelu potizovani 3D
dat se zaméfenim na movité predméty se dale vénujme jen statickému pozemnimu
laserovému skenovani. Laserovy skener se sklddd ze dvou ¢asti, a to z laserového
dalkoméru a skenovaciho mechanismu. Do dalkoméru je zabudovan pulsni laser,
ktery emituje velmi kratké zablesky infraCerveného svétla, a skenovaci mechanismus
urc¢uje smér vyslaného paprsku ¢imz se dostavame k zdkladnimu principu laserového

skenovani (Pavelka & Hodac, 2008)

Tim je méfeni vzdalenosti, kterou urazi laserovy paprsek od zdroje zateni k povrchu
skenovaného objektu. Tato vzdalenost je urCena Casem, ktery paprsek urazi od chvile jeho
vyslani ze zdroje az po jeho zpétné pfijeti po odrazu. Dilezitd je znalost polohy skeneru,
kterd se u pozemniho laserového skenovéani urcuje geodeticky, a pfesny smér vyslani
paprsku. (Orsulak & Pacina, 2012) Protoze zname smér vyslani paprsku a vzdalenost,
kterou urazi paprsek od zdroje zafeni k povrchu skenovaného objektu, 1ze obecné fict,

ze jsou podrobné body zaméteny hromadnou polarni metodou. (Pavelka & Hodac, 2008)

Vysledkem skenovani pfedmétu v uréitém zorném poli je tzv. mra¢no boda (point cloud),

mezi kterymi jsou pravidelné uhlové rozestupy. (Hodac, 2002)

Laserové skenovani je casto dopliiovano snimkovanim zamétovaného objektu digitalni
kamerou. Diky tomu lze pouZzit pofizené fotografie k obarveni mra¢na bodi, coZ zpusobi,

ze vysledny 3D model vypada realisticky.
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2.3 Geodetické metody

Geodetické metody se pouzivaji zejména v kombinaci s fotogrammetrickymi
metodami a laserovym skenovanim za uclelem transformace jednotlivych snimkt
nebo pofizeného mracna bodi do geograficky vztazeného soutadnicového systému.

(Bezd¢k et al., 2010)

Pro ziskani prostorovych souradnic jednotlivych bodl slouzi u geodetickych metod dvé
hlavni veliCiny, a to uhly a délky, které Ize métit pomoci totalnich stanic se zabudovanymi
dalkoméry. Dalkoméry pracuji bud® na principu elektrooptického méteni délek,

nebo na principu laseru.

Geodetické metody se v oblasti 3D modelovani pouZivaji vyhradn€ pro dokumentaci
nemovitych pamatek, at’ uz se jedna o dokumentaci exteriéri nebo dalSich prostorovych
prvki. Naopak nejsou vhodné pro dokumentaci rovinnych casti objektt (fasad)

a prostorové piili§ ¢lenitych objektu (napfiklad soch). (Hodag, 2002)
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3 Nemérické kamery

Predchozi kapitola byla vé€novéana technikdm sbéru dat se zaméfenim na movité
predméty, ve které jsme se u fotogrammetrickych metod setkali s moznosti pofizeni
snimki dvéma typy kamer. Jsou to kamery métické a nemérické, jejichz zékladni rozdil
spociva ve znalosti kalibracnich prvki kamer. Vzhledem k tomu, Ze je v této praci jednou
z porovnavanych metod sbéru dat pofizovani snimkid neméfickou kamerou, budeme se jimi

v této kapitole podrobnéji zabyvat.

Nem¢éfickymi kamerami jsou takové fotoaparaty, u kterych nejsou prvky vnitini orientace
znamy vibec, nebo pouze Castecné, a proto je (dle Pavelky, 2003) prace s takovymito
kamerami pouzivanymi pro fotogrammetrické ucely spojena s nutnosti ur¢eni nasledujicich

prvki:

e konstanta kamery - horizontalni a vertikalni (f, f,)
e soufadnice hlavniho snimkového bodu (c,, ¢y)
o radialni distorze (zkresleni) objektivu (K1, K5, K3)

e tangencidlni distorze objektivu (p4, p2)

Pro zjisténi téchto vlastnosti neméfickych kamer se pouzivaji dva typy kalibrace,
a to kalibrace pomoci testovaciho pole a simultinni kalibrace. (Cerpano z: Kalibrace

digitalnich fotoaparatl)

Princip kalibrace pomoci testovaciho pole je zaloZzen na snimkovani testovaciho pole
se signalizovanymi body (zndme jejich objektové soutfadnice nebo vzdalenosti mezi
nékolika body testovaciho pole) z n€kolika stanovisek tak, aby osy zabéru jednotlivych
snimki byly konvergentni a zarovenl aby snimany objekt (testovaci pole) byl zachycen
na dostatecném mnozstvi snimkt. Nasledné jsou ze znamych pifedmétovych soufadnic
a métenych snimkovych soufadnic bodu testovaciho pole vypocteny a vyrovnany prvky
vnéjsi a vnitini orientace. Kalibraci pomoci testovaciho pole umoziiuje naptiklad placeny
software PhotoModeler nebo volné dostupny kalibracni software Agisoft Lens, kde je

testovaci pole zobrazené piimo na monitoru pocitace.

Druhy zpiisob, ktery umoznuje ziskat hodnoty prvkll vnitini orientace, je simultanni
kalibrace. Tento zptisob kalibrace vyuzivame v piipadé, kdy méfeny objekt nema zadnou

vlastni strukturu nebo nejsou zndmy Zadné geometrick¢é informace objektu,
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které by umoznily provést autokalibraci. Testovacim polem muiize byt v nejjednodussim
pfipad¢ prenosny ram o znamych rozmeérech, ktery se postavi pfimo k zaméfovanému
objektu, a stdva se tak jeho soucasti. Takovéto snimkovani musi probihat za stejnych
podminek jako pii kalibraci samotnym testovacim polem. Tento zplsob kalibrace
umoziuje zjiSténi prvk( vnitini orientace piimo ze snimkd, které jsou pouzity

pro rekonstrukci objektu. Prvky vnéjsi orientace se pak urcuji pomoci vlicovacich bodd.

Je-li provadéna simultanni kalibrace pouze z fotogrammetrického pozorovani, pak se jedna
0 tzv. autokalibraci. Tato metoda ma stejny zaklad jako simultanni kalibrace tzn.,
ze se taktéz pocitaji kalibracni koeficienty pfimo ze z4jmového objetu, ale na rozdil od ni
se nemusi dodrZovat stejné podminky pro snimkovani jako pii kalibraci samotnym

testovacim polem.

V této praci je pro urCeni prvkl vnitini orientace pouzita autokalibrace, se kterou pracuje
nami pouzity software pro zpracovani snimkd neméfickou kamerou Agisoft PhotoScan

(vice v kapitole 5 Zpracovani dat).
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4 Sbér dat

Pocinaje touto kapitolou se pfesouvame k praktické ¢asti této prace, kterd zacina
sbérem dat. Zakladnim pozadavkem pro ziskani kvalitnich vstupnich dat je peclivé
naplanovani postupu jejich sbéru. V této kapitole se tedy budeme zabyvat podrobnym
popisem postupti a podminek, za kterych by méla byt pofizovana data ndmi zvolenymi
technikami sbéru dat ve 3D, a to pfi pozemnim laserovym skenovani a pii pofizovani

snimki neméfickou kamerou za vyuziti metody SfM.

V obou pfipadech se bude sbér dat tykat téhoz objektu. Ten bylo nutné zvolit tak, aby bylo
mozné analyticky vypocitat jeho skuteény objem a zarovenn aby obsahoval texturu.
Pro nase ucely byl proto vybran kryt na teodolit (viz Obr. 4.1) ve tvaru komolého jehlanu,
jehoz rozméry byly urCeny opakovanym méfenim délek vSech stran a jejich

zprumérovanim (vice v kapitole 6.1 Porovnani vysledkii na zaklade objemu).

Obr. 4.1 Predmeét sbéru dat - kryt na teodolit

4.1 Sbér dat pozemnim laserovym skenovanim

Pro pofizeni mracna bodli pozemnim laserovym skenovanim byl pouZzit piistroj
Leica Nova MS 50 MultiStation (viz Obr. 4.3), ktery spojuje totalni stanici s 3D laserovym

skenerem. Pfi maximalnim dosahu 300 m a rychlosti skenovani 1000b/s vykazuje 3D
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skener $um méfenych délek® hodnotu 1mm na 50 m. Absolutni polohova pfesnost
skenovani do 500 m je 2 mm + 2 ppm. (Leica Geosystems AG, 2013) Pro ukladani

méienych udajt ptistroj disponuje vnitini paméti a SD pamét'ovou kartou.

Prvnim krokem pii pofizovani dat je rozmysleni vhodné konfigurace stanovisek pfistroje.
Stanoviska by méla byt nejméné dvé v minimalni vzdalenosti 1,5 m od skenovaného
objektu (uvedeno v manualu pfistroje) a rozmisténa tak, aby byl naskenovan cely objekt
zajmu. Abychom se mohli pohybovat v mistnim soufadnicovém systému, byly v naSem
ptipad¢ pouzity dva odrazné hranoly (na Obr. 4.4 oznaceny jako TPS0001 a TPS0002)

vymezujici pfimku, k niz bylo vztaZzeno méfeni z kazdého stanoviska.

Po ptipravé stroje na prvnim stanovisku, zalozeni nové zakazky v pfistroji a provedeni
orientace métfeni k piimce se mizeme piesunout k samotnému nastaveni skenovani.
Vyhodou tohoto pfistroje je umoznéni definice nepravidelné oblasti skenované miizky.
Tato skuteCnost nam usnadni praci pii zpracovani naskenovaného mracna bodd,
jelikoz se laserovy paprsek pohybuje v pouze ndmi definované oblasti, ¢imz redukujeme
nadbyte¢ny pocet bodii mracna. Definice nepravidelné oblasti probihd nésledovneé:
dalekohledem postupné zacilime na tfi a vice bodi ve sméru hodinovych rucicek
a nasledné dojde k vypocteni skenované mtizky (viz Obr. 4.2). Po definovani skenované
oblasti potfidime jeji snimek, ze kterého jsou po naskenovani objektu pfifazeny barvy

jednotlivym bodim mracna.

> za ide4lnich podminek (zataZen4 obloha, objekt ve stinu, pfima viditelnost, staticky cilovy objekt)

23



Obr. 4.2 Definice skenované oblasti

V dals$im kroku je potfeba definovat rozliSeni skenovani, a to bud’ podle délky nebo uhlu.
V nasem piipad¢ byla zvolena moznost definice rozestupu bodi mracna podle délek,
které byly nastaveny na hodnoty 0,005m jak v horizontalnim, tak ve vertikalnim sméru,
abychom ziskali husté mra¢no bodu. Pti takovémto nastaveni jsme dosahli poctu 16 404

bodu z jednoho stanoviska.

Poslednim krokem ptedtim, nez spustime skenovani, je nastaveni rezimu skenovani.
To znamend, Ze je potieba urCit, s jakou rychlosti bude skenovani v zavislosti
na vzdalenosti od objektu probihat. V naSem piipadé jsme docilili rychlosti skenovani

1000b/s, protoze vzdalenost od skenovaného objektu byla mensi nez 300 m.

Po opakovani vyse zminéného postupu z kazdého stanoviska a obdrzeni vSech pottebnych
skenti je vhodné ovéfit spravnost jejich pofizeni. Pfistroj umoziiuje prohlédnuti vSech
skenu (viz Obr. 4.3), coz je vyhodné zejména v piipadech, kdy se dopustime hrubé chyby

v méfeni a nelze tak potfizené skeny sesit.
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Obr. 4.3 Leica Nova MS 50 MultiStation a zobrazeni skenii na displeji pristroje

Celkem bylo skenovani provedeno ze 3 stanovisek s oznacenim 0001, 0002, 0003
(viz Obr. 4.4). To znamena, ze jsme ziskali 3 skeny s vice nez 65 000 body. Tato data bylo

nutné nejprve vyexportovat na SD pamétovou kartu ve formatu XML, a nasledné prevést

v programu Leica Infinity do formatu PTS, ktery uchovava informace o barvach.

&
@ '
/ \
TPS 0001 =
0002 -
=2
~ - v
i
/ \
@ 0003
L J . s
'
/ \ ®
0001 TPS 0002

Obr. 4.4 Konfigurace stanovisek a primky
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4.2 Sbér dat nemérickou kamerou za vyuziti metody SfM

Ptfi vybéru kamery pro pofizeni snimkii byla hlavni prioritou jeji dostupnost,
a proto byla jako nejvhodnéjsi shledana takova, jez je soucasti mobilnich telefont. Volba
mobilniho telefonu zavisela na dodrzeni doporucenych parametrii fotoaparatu uvedenych
v uzivatelské piirucce softwaru PhotoScan Pro (vice v kapitole 5 Zpracovani dat),
kde uvedenymi podminkami pro pouzity fotoaparat je jeho minimalni rozliSeni 5 MPix
a ohniskova vzdalenost objektivu pohybujici se v rozmezi 20 - 80 mm. (Agisoft LLC,
2016b) Pro snimkovani jsme proto pouzili mobilni telefon Apple iPhone 4, ktery disponuje

fotoaparatem s rozliSenim 5 MPix a ohniskovou vzdalenosti objektivu 30 mm.

Pfi samotném snimkovani je nutné postupovat podle n¢kolika zasad. Zaprvé bychom méli
snimkovani uskute¢nit za vhodnych svételnych podminek, tzn. vyhnout se slune¢nému
pocasi nebo umélému svétlu, aby ndmi snimany objekt nebyl pfili§ pfesviceny nebo aby
na né¢j naopak nedopadal stin, coz by mélo nezadouci vliv nejen na samotnou rekonstrukci
3D modelu, ale také na jeho vyslednou texturu. Dale je vhodné omezit vyskyt nechténého
popiedi a pohybujicich se objekt uvnitt snimané scény. Pro potfizeni snimkl objektu je
dulezité pouzit stejné nastaveni ohniskové vzdalenosti, nebot’ pfi jeji mirné zméné se méni
1 zkresleni obrazu. Podle pouzité ohniskové vzdalenosti rozliSujeme dva druhy zkresleni.
V ptipadé, kdy pouZzijeme objektiv s dlouhym ohniskem, dostaneme zkresleni poduSkovité
(polstarkovite€), a naopak pii pouziti kratkého ohniska dostaneme zkresleni soudkovité (viz
Obr. 4.5). Navic dasledku pouziti objektivu s piili§ dlouhym ohniskem bychom
pii zpracovani snimkt dostali mracno bodd vykazujici pfili§ vysoky Sum. Vzhledem
k ohniskové vzdalenosti 30 mm, kterou disponuje pouzity mobilni telefon, l1ze oCekavat

mirné soudkovité zkresleni.

) b) 0
/ \
! \ T l
\ f o |
\ /

Obr. 4.5 Viiv zmény ohniskové vzdalenosti na zkresleni obrazu (distorze pole) - a) obraz je

zcela bez zkresleni, b) poduskové (polstarkové) zkresleni, c) soudkovité zkresleni
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Pouziti digitalniho zoomu, ktery pouzivaji fotoaparaty mobilnich telefont, ma vliv

na celkové rozliSeni obrazu, coz je v ptipadé zpracovani snimka v PhotoScan nezadouci.

Samotné snimkovéani by mélo probihat systematicky, kolem dokola snimaného objektu
a z riznych trovni, tak abychom kolem objektu vytvofili jakousi sféru (viz Obr. 4.6).
Obecné plati, Ze ¢im vice snimkid pofidime, tim 1épe. Ty by mély byt pofizeny tak, aby
snimany objekt zabiral co nejvétsi plochu snimku. V ptipadé, ze nastane situace, kdy neni

mozné zachytit cely objekt, je mozné zachytit jeho chybéjici ¢asti na dalsi snimek.

Obr. 4.6 Schéma snimkovani v pripadé izolovaného objektu

Aby bylo pozdéji mozné zrekonstruovat skute¢nou velikost objektu, je potieba soucasné
nasnimat spolu s objektem délkovy etalon. V nasem piipadé byla spolu s krytem

na teodolit nasnimana podlaha z dlazby, jejiz rozméry byly zméteny po potfizeni snimkd.

Abychom ziskali dostatecny pocet snimki, provedli jsme snimkovani ze 3 vodorovnych
rovin, a to ve vySce piiblizné¢ 20 cm, 40 cm a 100 cm od podlahy. Celkem jsme takto
ziskali 86 snimku ve formatu JPEG. Software Agisoft PhotoScan umi pracovat pouze
s originalnimi snimky (konkrétnéji s jejich pivodnimi EXIF metadaty), které nebyly
zadnym zpusobem modifikovany. Proto jsme neprovedli jejich ofiznuti ani jiné
geometrické upraveni. Kdybychom tak ucinili, mohlo by to vést k vysoce nepfesnému

vysledku pfi nasledné tvorbé 3D modelu nebo by snimky nebylo mozné zpracovat viibec.

27



5 Zpracovani dat

Data ziskana méfenim bylo nasledné nutné zpracovat. V ramci této kapitoly jsou

proto nejprve stru¢né charakterizovany zvolené programy pro zpracovani potfizenych dat.

Jsou jimi Meshlab v ptipad¢ zpracovani potizenych dat pozemnim laserovym skenovanim

a Agisoft PhotoScan pro zpracovani snimk metodu SfM. Dalsi program, ktery byl shledan

jako velice uzite¢ny zejména pii konverzi dat do potfebnych formati a nasledném

porovnavani vytvorenych 3D modeld, je program CloudCompare. V dalSich podkapitolach

jsou popsany postupy tvorby 3D modelu v programu Meshlab a tvorba 3D modelu

v programu Agisoft PhotoScan.

5.1 Pouzité programové vybaveni

Meshlab je voln¢ dostupny a pienosny software, ktery umoziuje vytvareni
a editaci 3D modelti z mracna bodd. Tento program vznikl jako studentsky projekt
na Univerzité v Pise v roce 2005 a v nasledujicich letech se pokracovalo ve vyvoji
jeho dalSich funkci. Software je dostupny pro vétSinu operacnich systémd, a to pro
Windows, Linux a Mac OS X. S omezenou funk¢nosti ho lze také pouzivat jako
aplikaci prostiednictvim mobilnich opera¢nich systému iOS a Android. (Meshlab,

2016; Prispivatelé Wikipedie, 2016b)

Agisoft PhotosScan je komer¢ni software, ktery umoziuje zpracovavat snimky
potizené jak méfickymi, tak neméfickymi kamerami. Tento software vyvinula
firma Agisoft LLC sidlici v Petrohradu a byl poprvé vydan v roce 2010.
Je dostupny pro vétSinu operacnich systému, mezi které patfi Windows, Linux
a Mac OS X. Vybér vhodné hardwarové platformy je velice dulezity pro efektivni
fungovani programu. Mnozstvi snimk, které¢ 1ze v PhotoScan zpracovat, je totiz
omezeno velikosti operaéni paméti RAM pocitace (nesmi byt nizsi nez 2 GB).
Vzhledem k tomu, ze se jedna o placeny program, byla v ramci této bakalarskeé

prace vyuzita pln¢ funk¢ni tficetidenni trialova verze. (Agisoft LLC, 2016b)

CloudCompare je voln¢ dostupny software, ktery byl pivodné vyvinut za Gcelem
pfimého porovnavani hustych mracen bodl. Pro efektivni praci, co se tyce

porovnavani dat, pouziva tento software metodu déleni prostoru, zndmou jako
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oktalovy strom - octree’. Pozd&ji byly funkce CloudCompare doplnény
o porovnavani mra¢na bodu s trojuhelnikovou siti, porovnavanim trojuhelnikovych
siti mezi sebou a spoustu dalSich algoritmi, které umoziuji editaci dat.
CloudComapre je dostupny pro opera¢ni systémy Windows, Linux a Mac OS X.
(CloudCompare 2016, Piispivatelé Wikipedie 2016a)

5.2 Tvorba 3D modelu v Meshlab

Prvnim krokem je import potfizenych dat (mracna bodi) do Meshlab pftes tlacitko File >
Import Mesh. Software podporuje import nékolika formati reprezentujicich 3D data,
mezi které patii napiiklad PLY, STL, OBJ, COLLADA, PTS, 3DS a mnoho dalSich
(viz Obr. 5.1). Prestoze Meshlab nabizi import formatu PTS, ve kterém jsme obdrzeli
naskenovana data, bylo nakonec nutné tento format konvertovat v programu
CloudCompare do formatu PLY (Polygon File Format), jelikoz import formatu PTS
neprobéhl tspésn€. Dlvodem je skutecnost, Ze formaty PTS jsou do Meshlab importovany
ve tvaru soufadnice bodu x,y,z + normaly téchto soutfadnic nx, ny, nz, které jsme u naseho
souboru postradali. Import mra¢na boda spole¢né s jeho barvami probéhl ve formatu PLY

uspésné.

® Oktalovy strom je hierarchicka stromové struktura zaloZena na postupném déleni prostoru tiemi rovinami

kolmymi na soufadnicové osy.
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3D-Studio File Format ( *.3ds)

Stanford Polygon File Format ( *.ply)

STL File Format ( *.stl)

Alias Wavefront Object ( *.obj)

Quad Object ( *.qobj)

Object File Format ( *.off)

PTX File Format ( *.ptx)

VCG Dump File Format ( *.vmi)
Breuckmann File Format ( *.bre)

Collada File Fermat ( *.dae)

OpenCTM compressed format ( *.ctm)
Expe's point set (binary) ( *.pts)

Expe's point set (ascii) ( *.apts)

XYZ Point Cloud (with or without normal) ( *.xyz)
GNU Triangulated Surface ( *.gts)

Protein Data Bank ( *.pdb)

TRI (photogrammetric reconstructions) ( *.tri)
ASC (ascii triplets of points) ( *.asc)

X3D File Format - XML encoding ( *.x3d)
X3D File Format - VRML enceding ( *.x3dv)
|VRML 2.0 File Format ( *.wrl)

Obr. 5.1 Formaty pro import do Meshlab

Po importu dat bylo nutné odfiltrovat body, které nechceme, aby se staly soucasti

vysledného 3D modelu. To je v programu umoznéno ikonou Select Vertexes =+ . Oblast

vybranych bodi je nasledné obarvena Cervené a tlacitkem Delete Selected Vertexes % Ji
smazeme. Ackoliv algoritmy, které slouzi pro rekonstrukci trojuhelnikové sité povrchu
(tzv. mesh), z casti odfiltruji nékteré body, které vznikly ruchem, je potiecba provést

manudlni ¢isténi mrac¢na bodt opravdu peclive, jinak bude vysledny 3D model neptesny.

Nyni mtzeme pfistoupit k rekonstrukci trojuhelnikové sit€¢ definujici povrch objektu.
Meshlab nabizi pro tento ucel nékolik zplsobi jeji rekonstrukce, nicméné ke dvéma

nejoblibenéjsim patii algoritmy Poisson Surface Reconstruction a Ball Pivoting.

5.2.1 Ball Pivoting

Princip Ball Pivoting algoritmu je velice podobny Delaunyho triangulaci. Lisi se vsak
od Delaunyho triangulace tim, ze 3 body tvofici polygon nemusi leZet pouze na zadaném
pruméru kruznice. Princip této metody je tedy jednoduchy - pokud se koule, jejiz polomér
je zadan uzivatelem, dotkne celkem tfi bodl a neobsahuje Zadny jiny bod, pak je z téchto
3 bodu vytvoren polygon. Jednim z negativ tohoto algoritmu je jeho vypocetni a pamétova

naroc¢nost, coz vede k delsimu ¢asu pii zpracovani. (Bernardini et al., 1999) Dalsi problém
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spocivd v tom, Ze nevytvaii uzaviené¢ 3D modely a nelze tak aplikovat funkci vypoctu

objemu, proto pro nase ucely nemohl byt pouzit.

5.2.2 Poisson Surface Reconstruction

Poissontiv algoritmus na rozdil od predesiého algoritmu "nepropustné" trojihelnikové sité
vytvaii. Nepropustnou trojuhelnikovou siti je myslena takova sit’, kterd neobsahuje diry.
Nejedna se o iterativni metodu rekonstrukce povrchu, ale uvazuje celou mnozinu bodi
najednou, a proto je do jist¢ miry odolny vici bodim, které vznikly Sumem nebo jsou
nerovnomérné rozlozeny. Zptsob rekonstrukce povrchu je pomérné komplikovany
a spociva ve 4 krocich nastinénych dale a zobrazenych na Obr. 5.2. Prvnim krokem je
vypocet normal jednotlivych bodl, druhym je aproximace gradientu indikatorové funkce
pomoci normal, dale je odvozena indikatorova funkce z gradientu vypocteného ve druhém

kroku a poslednim krokem vykresleni polygonalni sité. (Kazhdan et al., 2006)
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Obr. 5.2 llustrace jednotlivych krokit Poissonovy rekonstrukce ve 2D (Kazhdan et al.,
2006)

Prvnim krokem je tedy vypocet normal bodii tvoficich mracno, a to prostiednictvim
zalozky Filters > Normals, Curvatures and Orientation > Compute normals for point sets.
Nasledn¢ je potieba v dialogovém okné této funkce uptesnit hodnotu parametru
Neighbourhood number, coz je Cislo udavajici pocet nejbliz§ich bodu, které budou mit
spolenou normalu. V naSem piipadé¢ jsme toto cislo nastavili na hodnotu 16,
které vyplynulo z doporufeni pro zpracovani hustych mracen bodi uvedenych
na diskusnich férech programu Meshlab, a stiskli tla¢itko Apply. Cim vy$si hodnotu
nastavime tomuto parametru, tim vice bude vysledny povrch zaobleny. Vytvofené normaly
se v hlavnim okné objevi az poté, kdy aktivujeme funkci Show Vertex Normals v zalozce
Render. Dulezité je =zajistit, aby vytvofené normaly smeéfovaly smérem ven

od modelovaného objektu (viz Obr. 5.4). Pokud tomu tak neni, zaskrtneme v dialogovém
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okné pro Compute normals for point sets moznost Flip normals w.r.t. viewpoint a na tieti

pozici nabidky Viewpoint position vepiseme hodnotu 1000 (viz Obr. 5.3)

Compute the normals of the vertices of a mesh without exploiting the triangle
connectvity, useful for dataset with no faces

Neighbour num 16 }
Smooth Iteration :0 }

Flip normals w.r.t. viewpoint

Viewpoint Pos. ﬁl 0 I 1000 \ Get | View Dir v
Default Help
Close Apply

Obr. 5.3 Dialogové okno pro rekonstrukci normal mracna bodii

@ File Edit Filters Render View Windows Tools

NFTCYBEE

VL ERER] e I BRI T LI e

Obr. 5.4 Vypoctené normdly mracna bodii

Samotnou Poissonovu rekonstrukci povrchu najdeme v Meshlab v zalozce Filters >
Remeshing, Simplification and Reconstruction > Surface Reconstruction: Poisson.
Poté se na hlavni obrazovce objevi dialogové okno, ve kterém je potieba bliZe specifikovat
parametry Octree Depth a Solver Divide, které jsou defaultné nastaveny na hodnoty 6.
Parametr Octree Depth ma vliv na vyslednou pfesnost rekonstrukce povrchu. To znamena,
ze ¢im vys$i hodnotu tomuto parametru pfifadime, tim lepSi vysledek dostaneme.

Pozadavky na hardware nejsou pifimo umérné zvyseni této hodnoty, ale cas zpracovani je

s vy$$i hodnotou delsi. Hodnotu parametru Octree Depth jsme tedy nastavili na hodnotu
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12, kdy jsme obdrzeli nejlepsi vysledek. (viz Obr. 5.5) Parametr Solver Divide pomaha
snizit zatizeni pamé&ti za cenu prodlouzeni doby rekonstrukce povrchu. Tato hodnota byla

tedy dle doporuceni nastavena na hodnotu 8.

Obr. 5.5 Porovnani vysledkii vytvorené trojihelnikové sité povrchu za pouziti rozdilnych
hodnot parametru Octree Depth (zleva: Octree Depth = 6; Octree Depth = 8; Octree
Depth = 12)

Poslednim krokem je tvorba textury povrchu pfenesenim atributu barvy z plvodniho
mra¢na bodu. Prvnim krokem tohoto procesu je parametrizace textury, kterou muzeme
provést dvéma zpusoby - Trivial Per-Triangle nebo Flat Plane. Prvni zplsob
parametrizuje texturu pomoci trojuhelnikd, zatimco druhy zptisob podle roviny. Zvolime-li
pro parametrizaci textury trojuhelniky, pak v zalozce Filters > Texture vybereme moznost
Parametrization: Trivial Per-Triangle, kde je nasledné¢ nutné v dialogovém okné blize
specifikovat parametr pro rozliSeni textury Texture Dimension a dale ur¢it metodu,
podle které budou trojuhelniky pro texturu bud stejné velké (moznost Basic)
nebo piizpisobeny stavajici trojuhelnikové siti (mozZnost Space-optimizing). Tla¢itkem

Apply potvrdime vybér.

Ke druhému kroku patfi obarveni parametrizovanych trojuhelnikli pfenesenim atributu
barvy z pofizeného mra¢na bodu. V zalozce Filters > Texture vybereme moznost Transfer
Vertex Attributes to Texture (between two meshes). V dialogovém okné upfesnime
zdrojova data (Source Mesh) a cilova data (Target Mesh), definujeme rozméry textury
dle potieby (v nasem piipad¢é byly ponechdny defaultni hodnoty) a zaSkrtneme moznost

Assign Texture (pritadit texturu).
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Obr. 5.6 Vysledny 3D model s prirazenou texturou

Export vyslednych 3D modelii je umoZnén prostfednictvim formatd PLY, STL, OBJ,
COLLADA, DXF, 3DS, VRML a dalsich.
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5.3 Tvorba 3D modelu v Agisoft PhotoScan

Tvorba 3D modelu z dat ziskanych metodou SfM probiha v programu Agisoft PhotoScan.

Prvnim krokem je zde import snimku, které jsme obdrzeli ve formatu JPEG, pies tlacitko

Add Photos & v zalozce Workflow. PhotoScan kromé formatu JPEG dokaze zpracovavat
formaty TIFF, PNG a BMP.

Obr. 5.7 Neserazené importované snimky

Zpracovani snimkid v programu PhotoScan spociva celkem v 5 zdkladnich etapach. Prvni
z nich je vyrovnani importovanych snimk, které provedeme v zalozce Workflow > Align
Photos. Béhem tohoto procesu program vyhledava spole¢né body nachazejici se
na snimcich a nasledné snimky spojuje. Dale prostfednictvim algoritmu Structure from
Motion rekonstruuje pozice kamer kazdého ze snimku a autokalibraci uptesiiuje kalibra¢ni
prvky fotoaparatu. Pofizujeme-li snimky dvéma a vice odliSnymi kamerami,
pak jsou snimky nalezejici téZze kamete rozdéleny do skupin na zakladé¢ EXIF metadat
snimki, kterd obsahuji mimo jiné rozliSeni snimkd nebo pouzitou ohniskovou vzdélenost
kamery. Tento proces lze provést taktéZz manualné (Create Group) uzivatelem
v dialogovém okn¢ Camera Calibration, které najdeme v zalozce Tools. Dale je

zde mozné upravit kalibra¢ni prvky kamery (viz Obr. 5.8).
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= Camera Calibration = =
5 Phoned (385 mm) =l Frame =
87 images, 2592x1936 pix Pixel size (mm): 0.0014711 x |0.0014711
Focal length {mm): 3.85
Initial Adjusted
E
2475.63 o | 1318.41
2475.63 cy: |975.465
k1: 0.136292 pl: |0.000523847
k2: -0.830762 p2: |-0,000431083
k3 |0.642445 p3: |0
k& |0 pd |0
skew: |0
Image . Resolution Camera model Focal length Date & time  *
[=] 1mG_2056.0.. 2592¢1936 iPhone 4 3.85 2016:02:01 13:0
I(T| MR INST I I507.103R iDhnne A 108 RN 1:.)n
Cancel

Obr. 5.8 Dialogové okno pro upresnéni kalibracnich prvkii kamery

Proces vyrovnani snimkt obsahuje v zalozce General dva parametry, a to Accuracy a Pair
preselection, které je nutné upiesnit. Parametr Accuracy nabizi celkem 5 moznosti
- Lowest, Low, Medium, High a Highest, kdy jsme zvolili nejvy$s§i moznou ptesnost
(Highest) za cenu delsi doby zpracovani snimkt.. Druhy parametr, Pair selection, slouzi
k urychleni procesu zpracovani snimkii diky vybéru podmnoziny obrazovych dvojic
ze sady importovanych snimkii. K vybéru podmnoziny dochédzi bud’ prostfednictvim
prekrytu snimkti (moznost Generic) nebo znalosti pozic kamery (moznost Reference).
Vzhledem k tomu, ze pozice kamer nejsou v nasem piipad¢é znamy, vybrali jsme moznost
Generic. V zalozce Advanced nalezneme dva parametry, a to Key point limit a Tie point
limit. Key point limit udava horni hranici bodu nalezenych na kazdém snimku, které¢ maji
byt brany v uvahu pro nasledné zpracovani. Pokud tento parametr nastavime na hodnotu
nula, PhotoScan se bude snazit najit tolik bodt, kolik bude mozné, avSak na ukor jejich
pfesnosti. Proto jsme tomuto parametru nastavili konkrétni hodnotu, a to 60 000. Parametr
Tie point limit udava horni hranici vybéru nejkvalitnéji urCenych odpovidajicich si boda
na kazdém snimku. Vysledkem je fidké mra¢no bodu (Sprase Cloud) a vypocétené pozice
kamer (viz Obr. 5.9).
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Obr. 5.9 Ridké mracno bodii s rekonstruovanymi pozicemi kamer

Druhym velice dulezitym krokem pfi zpracovani snimku je obohaceni fidkého mrac¢na
bodu o dalsi body, ¢imZ dostaneme husté mracno bodu (Dense Cloud). V tomto kroku jsou
vypocitavany informace o hloubce obrazu vSech snimkt, které maji byt slouceny
do jednoho mrac¢na bodi. Toho docilime v zalozce Workflow > Build dense cloud,
ve které je potieba upfesnit dva parametry - Quality a Depth Filtering. Parametr Quality
nabizi moznosti Lowest, Low, Medium, High a Ultra High. Stejné¢ jako v piedeslém
ptipadé byl tento parametr nastaven na nejvyssi moznou piesnost generovani hustého
mra¢na bodt, tedy na moznost Ultra High. Parametr Depth filtering pomaha redukovat
body, které vznikly ruchem nebo ze Spatné¢ zaostfenych snimki. Nabizi celkem tfi
algoritmy udavajici hloubku filtrace obrazu - Aggressive, Moderate a Mild. Moznost
Aggressive volime v piipadé, ze modelovany objekt neobsahuje zadné drobné detaily,
které je potieba ve vysledném 3D modelu zachovat. Moznost Mild naopak tyto drobné
detaily zachovava a je navic uzitetna v piipad¢, kdy modelovany objekt neobsahuje
texturu. Tteti moznost, Moderate pfinasi vysledek, ktery je primérem dvou piedchozich
moznosti. Pokud nechceme filtrovat hloubku obrazu, miZzeme zvolit ¢tvrtou moznost
Disabled, ktera je taktéz v nabidce tohoto parametru. Pouziti této moZnosti
se vSak nedoporucuje, protoze vysledné husté mra¢no bodii bude vykazovat spoustu bodt
vzniklych ruchem. Abychom tedy docilili co nejvice podrobného hustého mra¢na bodu,

zvolili jsme pro tuto praci moznost Mild.

Z Obr. 5.10 je zifejmé, ze krom¢ bodu definujicich modelovany objekt, vzniklo mnozstvi

nadbyteénych bodl, které je potfeba odfiltrovat. Pro snadnéj$i vybér téchto bodi
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PhotoScan nabizi nekolik tlasitek ot 4 kterymi dojde k jejich hromadnému

vybéru, oznaceni a nasledné stisknutim tlacitka Delete Selection x k jejich odstranéni.

Obr. 5.10 Husté mracno bodii pred filtraci nadbytecnych bodiu

Ke treti etapé patii vytvofeni trojuhelnikové sit€ povrchu (meshe) prostiednictvim
ziskaného hustého mra¢na bodu. K tomu slouzi funkce Build Mesh, kterou nalezneme
v zalozce Workflow. Tato funkce nabizi oproti pfedchozim funkcim vice parametri,
které je potieba definovat. Prvnim z nich je parametr Surface Type, ktery urluje,
jakym zptsobem bude povrch modelovaného objektu zpracovan. Parametr ma na vybér
dvé moznosti - Arbitrary nebo Height Field. Moznost Arbitrary by méla byt zvolena
pfedevSim pro objekty uzavieného a ¢lenitého charakteru, kterymi jsou naptiklad sochy.
Zpracovani dat touto metodou vSak vyzaduje vice ¢asu, protoze klade vyssi pamétové
naroky na vypocet. Naopak ¢asové mén¢ narocnou moznosti pro tvorbu trojuhelnikové sité
povrchu je moznost Height Field, jejiz aplikovani je ucelné pifi modelovani rovinnych
povrchi a ne pfili§ Clenitych reliéfa. Je tedy vhodna zejména pro zpracovani
ortofotosnimkli pofizenych leteckym snimkovanim. Druhy parametr se jmenuje Source
data a jiz z nazvu je ziejmé, Ze slouzi pro volbu zdrojovych dat, ze kterych bude tvotfena
trojihelnikové sit’ definujici povrch modelovaného objektu. Generovani trojihelnikové sité
povrchu mutze probihat na zakladé¢ pouziti Fidkého mra¢na bodi (Sprase cloud)

nebo hustého mraéna (Dense cloud). Dalsim parametrem je Polygon count, ktery udava
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pocet trojuhelnikli, ze kterych bude vysledny povrch tvofen. Na vybér mame ze tii
moznosti - Low, Medium a High, pti¢emz u kazdé z nich je uveden pocet boda vstupniho
mracna a pocet polygond ve vysledné trojihelnikové siti. Chceme-li tyto hodnoty nastavit

dle vlastniho uvazeni, zvolime moZznost Custom, ktera dopliiuje tii vySe zminéné moznosti.

Poslednim parametrem je Interpolation, ktery se dotazuje, zda chceme provést interpolaci
¢i nikoliv. Povoleni prubéhu interpolace (Enabled) vSak neni v PhotoScan doporuceno,
protoze tak dochéazi k vyplnovani povrchu polygony i v oblastech, kde body chybi
z divodu nedostatecného piekryti vstupnich snimkl, a mizeme tak docilit nepfesného
vysledku. Vyplnéni dér v povrchu by tedy mélo byt soucasti post processingu. V zalozce
Tools > Mesh > Close Holes pak mizeme manualné definovat maximalni velikost dér,

které maji byt vyplnény extrapolovanymi daty.

Obr. 5.11 Trojuhelnikova sit definujici povrch objektu po uzavreni der

Dalsi etapou tvorby 3D modelu je pfifazeni textury povrchu modelovaného objektu (viz
Obr. 5.12), pro které slouzi funkce Build Texture v zalozce Workflow. Abychom ziskali
kvalitni texturu a tim padem veérohodnéji vypadajici vysledny 3D model, je potfeba vhodné
zvolit jednu z péti moznosti, kterou nabizi parametr Mapping mode. Prvni z nich je
defaultné nastavena moznost Generic, kterd umoziuje pokryt povrch texturou u predmétu

libovolné geometrie. Moznost Spherical je vhodné pouzit u predmétu kulovitého
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nebo oblého charakteru. Posledni moznost, kterd je méné vhodnd pro pouziti
pii modelovani movitého predmétu je moznost Single photo generujici texturu povrchu
na zaklad¢ jednoho snimku. Dale jsou v nabidce parametru Mapping mode uvedeny
jesté dvé moznosti, a to Adaptive ortophoto a Ortophoto, které maji vyuziti v piipadé,

ze vystupem bude ortofotosnimek.

Druhym parametrem pro vytvofeni textury je Blending mode, ktery urluje,
jakym zptisobem budou hodnoty pixelti z rliznych snimk kombinovany ve vysledné
texture. Na vybér mame ze ¢ty moznosti. Prvni z nich je Average, kterd vypocitd hodnotu
pixelu z jednotlivych snimkd na zakladé¢ vaZeného priméru a ndasledné ji pfifadi
konkrétnimu mistu v textute. Moznosti Min intensity a Max intesity piitadi pixelu hodnotu
s minimalni nebo maximalni intenzitou. Dal$i moznosti, kterd je vhodnd zejména
pro generovani textury ortofotosnimku, je moznost Mosaic. Ta voli hodnotu pixelu tak,

ze vybere hodnotu toho pixelu, ktery je nejblize stfedu snimku.

8585

Obr. 5.12 Vysledny 3D model s prifazenou texturou
Poslednim krokem je rekonstrukce skute€ného meétitka modelovaného objektu
prostiednictvim méfené délky, kterd byla ziskana pfi sbéru dat. Nejprve je nutné oznacit
misto na snimcich, kde byla ziskana omérna mira (v naSem piipadé okraje dlazdice),

coz umoziuji tzv. markery (znacky). Na misté snimku, kde chceme tuto znacku umistit,
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stiskneme pravé tlacitko mysi a v kontextové tabulce vybereme moznost Create Marker.
Dulezité je zajistit, aby se téZe misto nachazelo nejméné na dvou rozdilnych snimcich.
Dale v zalozce Reference soucasné oznac¢ime body (v naSem piipadé s nazvem point 1
a point 2), které zna¢i pocate¢ni a koncovy bod mista, kde byla ziskdna omérna mira,
a v kontextové tabulce zvolime moznost Create Scale Bar. Nakonec vlozime do tabulky

s nazvem Scale Bars pozadovanou hodnotu na odpovidajici pozici sloupce Distance.
(viz Obr. 5.13)

teference - & x| Model |
Undo e =
TEE hh %

Cameras Longitude Latitude Wil
9 & M6_20.. 13.351792 49726569

V1 [& ma_20.. 13351581 49.726811

vl IMG_20... 13.351803 49.726456

v [&] m6_20... 13.351803 49.726456

9 [E] 1m6_20.. 13.351803 49.726456

v IMG_20... 13.351803 49.726456

vl IMG_20... 13.351800 49.726497

9 & M6_20.. 13.351200 49726497 v
< >
Markers Longitude Latitude Alti
1% point 1

1% point 2

Total Error

< >
Scale Bars Distance (m) Accuracy (m)

v point1_.. 0.400000 0.001000

Total Error a

Obr. 5.13 Zména mé¥itka 3D modelu

Pro export vysledného 3D modelu PhotoScan nabizi nékolik formata (viz Obr. 5.14).
V zalozce File vybereme moznost Export Model a zvolime format exportu. Béhem exportu
je nutné zvolit soufadnicovy systém 3D modelu a dalsi volby exportu, jako je zachovani
textury 3D modelu a format jejiho exportu. Déle je umoZnén export modelu v podobé

mracna bodu (Export Points) do textového souboru nebo do formatu LAS.

Wavefront OBJ (*.obj)

305 models (%.3ds)

YRML models (*wrl)
COLLADA (*.dae)

Stanford PLY (".ply)

STL models (*.stl)

Autodesk FBX (*.fbx)
Autodesk DXF Polyline (*.dxf)
Autodesk DXF 30Face (F.dwf)
3D models (*.u3d)

Adobe PDF (*.pdf)

Google Earth KMZ (*.kmz)

Obr. 5.14 Formaty pro export programu PhotoScan
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6 Porovnani vyslednych 3D modelii

Jak jiz bylo zminéno v tvodu, cilem této prace je porovnat techniku sbéru dat bézné
dostupnym hardware, v naSem pfipadé mobilnim telefonem, za vyuziti metody StM
s metodou vyuzivajici geodeticky pfesny hardware, laserovym skenovanim. Porovnani
téchto technik je provedeno nejen na zékladé¢ vyhod a nevyhod vyplyvajicich z vlastniho
meéteni (viz Diskuze), ale také prostfednictvim vypoctu objemd 3D modelt vytvofenych
na zaklad¢ takto potizenych dat a naslednym porovnanim s analyticky vypocétenym
objemem predmétu sbéru dat. Porovnani vyslednych 3D modelt je taktéz provedeno
v programu CloudCompare prostifednictvim vypoctenych povrchovych odchylek. Cilem
této kapitoly je ujasnit zptisob, jakym doslo k vypocteni a porovnani objemu vyslednych
3D modeli, a nasledné zdivodnit mozné nepiesnosti vyslednych 3D modelti na zakladé

vypoétenych povrchovych odchylek v programu CloudCompare.

6.1 Porovnani vysledkii na zakladé objemu

Pro porovnani vysledkd jsme nejprve vypocitali objem modelované¢ho objektu analyticky,

kdy jsme vychazeli z predpokladu, Ze se jednd o komoly jehlan:

1
V=g3v (Sy+ /515, + S2),

kde v je vyska komolého jehlanu, S; je obsah dolni podstavy jehlanu a S, je obsah horni
podstavy jehlanu.

Obr. 6.1 Rozmery modelovaného objektu
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Me¢teni délek podstav a, b a vysky v télesa jsme provedli celkem pétkrat. Nasledné jsme
vypocitali praimér méfenych délek, ktery byl nésledné¢ zahrnut do vypoctu. Vysledné

hodnoty jsou uvedeny v nasledujici tabulce.

Strana podstavy[m] Vyska[m]

aq a, as a, b1 bz b3 b4_ Vv

0,535 | 0,534 | 0535 | 0535 | 0,208 | 0,202 | 0,203 | 0,202 0,602

0,535 | 0,535 | 0,535 | 0,536 | 0,203 | 0,202 | 0,203 | 0,201 0,602

0,535 | 0,535 | 0,534 | 0,535 | 0,203 | 0,201 | 0,202 | 0,202 0,603

0,536 | 0,534 | 0,534 | 0,536 | 0,203 | 0,202 | 0,203 | 0,201 0,602

gl | W N

0,535 | 0,535 | 0,534 | 0,535 | 0,203 | 0,202 | 0,203 | 0,202 0,603

Pr[ﬁ”;é’ 0,535 | 0,535 | 0,534 | 0,535 | 0,203 | 0,202 | 0,203 | 0,202 0,602
m

Tab. 6.1 Hodnoty meérenych délek

Dalsim krokem byl vypocet objeml vytvoienych 3D modeld v programech Meshlab
a Agisoft PhotoScan. Abychom ziskali co nejspolehlivéjsi vysledky, bylo nutné jiz pii
prabéhu zpracovani dat v programech Meshlab a Agisoft PhotoScan odstranit body,
které by délaly model c¢lenitym. Ptikladem jsou body reprezentujici uchyty Kkrytu
na teodolit nebo spony na uzavieni krytu (viz Obr. 6.2), se kterymi jsme pii analytickém

vypoctu nepocitali.

Obr. 6.2 Casti modelovaného predmétu, které bylo nutné z dat odstranit
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Déle bylo nutné ofiznout 3D model vytvofeny v programu Meshlab. Data ziskana
pozemnim laserovym skenovanim neobsahovala body definujici dno skenovaného objektu.
Poissontv algoritmus, ktery byl zvolen pro rekonstrukci povrchu, vytvari topologicky ¢isté
trojihelnikové sité, presto vSak v pripadé absence vétSiho mnozstvi bodl interpoluje tato
mista a dopliuje je body na ukor nechténych deformaci (viz Obr. 6.3) Proto jsme tedy
béhem cisténi pofizeného mracna bodi zachovali body reprezentujici rovinu podlahy,

abychom pak m¢li moznost vysledny 3D model podle této roviny ofiznout.

Obr. 6.3 Deformace dna Poissonovym algoritmem pro rekonstrukci trojuhelnikové sité

Funkci vypoctu objemu nabizi oba programy, ve kterych jsme data zpracovavali.
U Meshlab ji najdeme v zalozce Filters > Quality Measure and Computations > Compute
Geometric Measures. U PhotoScan tuto funkci nalezneme nasledovné: Tools >Mesh >

Measure Area and Volume.

Déle jsme také v ptipadé¢ pozemniho laserového skenovani provedli vypocet objemu
naskenovaného mracna bodli. To je umoznéno pifimo v pouzitém pfistroji v zalozce
Survey+ > Quick Volume. Zde jsme ale neméli moznost odstranit body reprezentujici

uchyty a spony krytu nebo body, které vznikly ruchem.
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6.1.1 Vysledné porovnani na zakladé objemii

Zvolena technika
Am}:));tézi(y Laserové skenovani SM k’;fn”é?(;lljkou
vy
Mracno bodil 3D model 3D model Agisoft
(Meshlab) PhotoScan
Objem [m3] 0,08750 0,08763 0,08664 0,08650
Absolutni
odchylka od
analyticky - 0,00013 0,00086 0,00100
vypocéteného
objemu [m3]
Rozdil od
analyticky . 015 098 1,14
vypoctencho
objemu [v %]

Tab. 6.2 Vysledné objemy

Z vySe uvedené tabulky je patrné, Ze vysledné objemy 3D modelli vytvofenych
v programech Meshlab a PhotoScan, se od sebe vyrazné nelisi, nebot’ jejich procentualni
odchylka ¢ini 0,16%. Na zakladé¢ vypoctu objemu mracna bodi v pfistroji mizeme
vylouc¢it moznost, ze doSlo k chybé pfi samotném sbéru dat. Abychom vyloudili také
moznost, ze byly vyse uvedené procentualni odchylky od analyticky vypocteného objemu
zpusobeny nespravnym ofiznutim dna 3D modelt, provedli jsme v programu
CloudCompare jejich porovnani (viz kapitola 6.2 Porovnani v CloudCompare) S Cistym
mraénem bodd’ na zéklad® povrchovych odchylek. Nakonec jsme provedli rovnéz

vzajemné porovnani obou vytvofenych 3D modelt.

’ mragno bodi bez bodt vzniklych ruchem a bodt reprezentujici uchyty a spony krytu
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6.2 Porovnani v CloudCompare

Nejprve jsme do programu CloudCompare importovali oba vytvofené modely
ve formatech PLY. Daéle jsme ztotoznili projek¢éni centra obou modelt funkci Match
bounding-box centres, ¢imz jsme provedli jejich "hrubou" registraci. Pomoci funkce Finely
registers already (roughly) aligned entities (cloud or meshes) jsme provedli jejich prvni
"jJemnou” registraci a zaroven jsme jeden model ur€ili referen¢nim (Model) a druhy
porovnavanym (Data). Zaroven jsme upiesnili hodnotu Error difference, coz je kritérium
zastaveni registrace, na 1.000e-10. Nasledn¢ jsme provedli druhou jemnou registraci, kdy

jsme parametru Error difference ptifadili hodnotu 1.000e-20.

Poté jsme provedli vypocet povrchovych odchylek pomoci funkce Cloud/Mesh Distance,
kterd krom& porovndni mracna bodl s trojihelnikovou siti povrchu umoziuje provést
porovnani mezi dvéma trojuhelnikovymi sitémi. Nejprve bylo nutné zvolit referencni
model (Reference) a porovnavany model (Compared). Dale probéhl vypocet ptibliznych
nejvyssich a nejnizsich vzdalenosti mezi modely, které jsou zobrazeny v tabulce Approx.
results. Podle téchto hodnot jsme nastavili v dialogovém okné pro piesny vypocet
vzdalenosti nejvyssi vzdalenost (Max dist.) na hodnotu 0,05 m. Nastaveni hodnoty
parametru Octree level pfizpusobi CloudCompare vypoétu sam. Zménénim této hodnoty
ovlivnime pouze dobu trvani vypoctu. Nakonec jsme stisknutim tlacitka Compute provedli

vypocet.

Vysledkem byla vizualizace povrchovych odchylek pomoci barevné stupnice, kde jsou
zaporné hodnoty znaceny modrfe a kladné hodnoty ¢ervené. Zobrazeni histogramu ¢etnosti

povrchovych odchylek umoziiuje funkce Show histogram.

6.2.1 Vysledné porovnani na zakladé povrchovych odchylek

Po porovnani 3D modelu vytvoreného v programu Meshlab s Cistym mracnem bodi,
na zéklad¢ kterého byl tento 3D model vytvoren, byly v programu CloudCompare zjistény
povrchové odchylky dosahujici az 43 mm ve spodni ¢asti objektu (viz Obr. 6.4). Vzhledem
k tomu, Ze se takovéto povrchové odchylky vyskytovaly pouze na jedné ze stén

modelovaného predmétu, chybu v ofiznuti dna jsme vyloucili.
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Z Obr. 6.5 je ziejmé, ze k takto vyraznym povrchovym odchylkdim doslo v misté,
kde potizené mracno bodl vykazovalo nejvyssi mnozstvi bodi vzniklych ruchem, nejspise
v disledku Spatné odrazivosti povrchu. Tyto body bylo nutné v pribéhu zpracovani dat
odstranit, coz mé€lo za nasledek skute¢nost, ze v téchto mistech nemélo ¢isté mracno bodi

dostatecné rozliSeni pro kvalitni rekonstrukci povrchu.

0.031390

0.027520

0.01

0.015910
0.012040
0.008170
0.004300
0.000431
-0.003439

-0.007309

-0.011179

Obr. 6.4 Povrchové odchylky mezi cistym mracnem bodit a 3D modelem vytvorenym

v Meshlab

Obr. 6.5 Body vzniklé ruchem

47



Ve srovnani s povrchovymi odchylkami, které jsme obdrzeli v pfedchozim ptipadé (Cisté
mracno bodl vs. Meshlab), jsme v ptipad€ porovnani ¢istého mracna bodd s 3D modelem
vytvofenym v programu PhotoScan nezaznamenali tyto odchylky takto vysoké, piesto se
vSak vyskytovaly ve vy$§i mife. K nejvyraznéj§im povrchovym odchylkam (az 23 mm)
doslo na boc¢nich sténach a horni podstavé modelovaného predmétu (viz Obr. 6.6). Tyto
odchylky budou nejspise zpiisobeny tim, Ze modelovany predmét nemél ptili§ bohatou

texturu.

C2M signed distances[«0.023]

0.016671

0.014660

0.012649

0.010639

0.006617

0.004606

0.002596

-0.005448

-0.007458

-0.011480
-0.013491

Obr. 6.6 Povrchové odchylky mezi cistym mracnem bodit a 3D modelem vytvorenym

v PhotoScan
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C2M signed distances[<0.05]
0.050000

0.045782

0.041564

0.037346

0.033128

0.028910

0.024693

0.020475

0.016257

0.012039

0.007821

0.003603

-0.000615

-0.004833

-0.009051

-0.013269
-0.017487

Obr. 6.7 Povrchové odchylky mezi 3D modelem vytvorenym v Meshlab a 3D modelem
vytvorenym v PhotoScan

Co se tyCe porovndni 3D modelu vytvofeného v programu Meshlab s 3D modelem
vytvofenym v programu PhotoScan, nejvyS$i povrchové odchylky jsme zaznamenali
ve spodni Casti objektu, které jsou srovnatelné s témi, které jsme obdrZeli v ptipadé

porovnani 3D modelu vytvofeného v Meshlab s ¢istym mracnem bodd.
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Diskuse

Z vysledkli uvedenych v kapitole 6 Porovnani vyslednych 3D modelii je patrné,
7ze pokud bychom testovali pifesnost technik sbéru dat bézné dostupnym hardware
za vyuziti metody SfM a statického pozemniho laserového skenovani pouze na zakladé
porovnani objemil vytvorenych 3D modeld v programech Meshlab a Agisoft PhotoScan
s analyticky vypoctenym objemem predmétu, pak by byl vysledek ptesnosti pro statické
laserové skenovani zavadéjici. Divodem je skutecnost, ze nékterd mista skenovaného
pfedmétu vykazovala niz$i odrazivost povrchu, a vznikl tak velky pocet bodd, které bylo
nutné odstranit. Nedostatecné rozliSeni mracna bodu v téchto mistech mélo za nésledek
nekvalitni rekonstrukci povrchu. Dikazem jsou vypoétené povrchové odchylky mezi
vytvofenym 3D modelem v programu Meshlab a ¢istym mra¢nem bodi, na zakladé

kterého byl tento 3D model vytvoten.

V piipad¢ potizeni dat mobilnim telefonem za vyuziti metody SfM a zpracovanim snimki
v programu Agisoft PhotoScan se na zaklad¢ zjiSténych povrchovym odchylek mezi takto
vytvotenym vyslednym 3D modelem a ¢istym mra¢nem bodid domnivame, Ze procentualni
odchylka 1,14% od analyticky vypocteného objemu byla zplsobena tim, modelovany
pfedmét nemél v nékterych mistech pfili§ bohatou texturu. Bohuzel nemtzeme v ramci této
préace posoudit, do jaké miry ovliviiuji pfesnost vysledného 3D modelu parametry pouZité

kamery mobilniho telefonu.

Vyhodami techniky sbéru dat neméfickou kamerou za vyuziti metody Structure from
Motion, je bezpochyby cenova dostupnost, rychlost sbéru dat, automatizovanost
a jednoduchost ve zpracovani pofizenych snimkl. Dalsi vyhodou je vysoce realisticky
vzhled 3D modelu, nebot’ vyslednd textura je pfejimana z pofizenych snimkd. To je oviem
vykoupeno niz$i piesnosti vysledného 3D modelu a vys$Simi poZadovanymi naroky
na hardware, s ¢imz souvisi del§i doba zpracovani. V nasem piipadé mél pouzity hardware
nasledujici parametry - 1.8 GHz CPU, 2 GB GPU, 6 GB RAM a proces zpracovani 86

pofizenych snimk trval pfiblizné 4 hodiny.

Dale v ptipadé€ pouziti mobilniho telefonu, jehoZz kamera disponuje digitdlnim zoomem, je
nevyhodou skutecnost, Ze vzdalenost od snimaného objektu je zavisla na velikosti objektu.
Pro kvalitni rekonstrukci 3D scény je nutné pii snimkovani zajistit, aby snimany objekt

zabiral co nejvétsi plochu snimku, coz neni vhodné provést ptiblizovanim objektu
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ve snimané scéné digitadlnim zoomem. Digitalni zoom pracuje na principu vyiezu stfedoveé
¢asti zabéru, ¢imz se snizuje rozliSeni snimku. To vede pfi zobrazeni na stejné velkou
plochu k snizeni kvality, tzv. rozpixelovani, které je v ptipad¢€ pouziti softwaru Agisoft
PhotoScan nezadouci. Abychom mohli snimkovat z vétsi vzdalenosti a nepfisli o kvalitni
rozliSeni snimkl, museli bychom pouzit kameru disponujici optickym zoomem,
ktery na rozliSeni nema vliv. V dnes$ni dobé vétSina digitalnich fotoaparati kombinuje
vlastnosti digitdlniho a optického zoomu, a proto by cenova dostupnost neméla byt

omezujici.

Co se tyce statick¢ého pozemniho laserového skenovani, velkou vyhodou je nepochybné
pfesnost potizenych dat a velkd vzdalenost, ze které 1ze data pofizovat, protoze laserovy
paprsek ma dosah az 1000m. Nevyhodou této techniky sbéru dat oproti snimkovani
neméfickou kamerou za vyuziti metody SfM je v prvni fade cena laserového skeneru a jista
mira erudovanosti méfiCe. Dal$i nevyhodou je minimalni vzdalenost pfistroje
od skenovaného objektu 1,5m. Takovato minimalni vzdalenost muiize skytat problém
pii potfebé skenovani pfedmétu umisténého v malych prostorach. Navic, i pfestoze se
jednd o bezkontaktni metodu sbéru dat, neni v nékterych ptfipadech pamaéatkové
dokumentace mozné pouzit laserové skenovani, protoze laserovy paprsek muze poskodit
pamatku. Déle v pfipadé rekonstrukce 3D tvaru pfili§ lenitych nebo bohaté texturovanych
movitych pfedmétl, nelze shledat vizualni kvalitu vysledného 3D modelu vytvofeného
na zakladé dat ziskanych pouze laserovym skenovanim jako dostacujici. To je zptisobeno
tim, Ze je barva textury vysledného 3D modelu piejimana z potfizeného mra¢na boda
a nasledné je pfifazovédna jednotlivym polygoniim tvofici povrch modelu, coZ nevypada
ptili§ jednotné. Dalsi pfi¢inou nedostateéné vizualni kvality 3D modelu je skutecnost,
ze pouziti Poissonova algoritmu pro rekonstrukci povrchu zptsobi dojem, jako by byl

modelovany predmét polity voskem.

Z vySe zminénych nevyhod laserového skenovani proto vyplyvaji piipady, ve kterych by
bylo mozné nahradit laserové skenovani technikou sbéru dat bézné dostupnym hardware
za vyuziti metody SfM. To znamena v piipadech, kdy z davodu malych prostor, ve kterych
se nachazi predmét sbéru dat, neni mozné dodrzet minimalni vzdalenost laserového
skeneru od skenovaného objektu 1,5m. Dale pak v ptipad€, kdy neni mozné pouzit

laserovy skener z dGvodu moznosti poskozeni pfedmétu laserovym paprskem,
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a nakonec také v ptipadech, kdy pozadujeme vybornou vizudlni kvalitu vysledného 3D

modelu.
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Zavér

Cilem této bakalaiské prace, jejiz nazev zni Rekonstrukce 3D tvaru movitého predmétu
zvolenou technikou, bylo porovnani technik sbéru dat bézné dostupnym hardware, tedy
neméfickou kameru za vyuziti metody SfM s technikou vyuzivajici pro sbér dat geodeticky
pfesny hardware, laserovym skenovdnim. Porovnani technik bylo provedeno vlastnim

meéfenim a naslednym zpracovanim dat.

Prace je rozd€lena na teoretickou a praktickou ¢ast. V teoretické ¢asti jsme se nejprve
zabyvali souc¢asnym stavem feSeni rekonstrukce 3D tvaru movitého pfedmétu, kde byla
pozornost soustfedéna predevSim na nizkondkladové techniky sbéru dat. Druha kapitola
byla reSersi technik sbéru dat ve 3D pozemnimi metodami dalkového prizkumu, kde jsme
objasnili  zakladni principy fotogrammetrickych metod, laserového skenovani
a geodetickych metod, které jsou vhodné spise jako dopliujici metody vySe zminénych
metod. Dale jsme navazali kapitolou, ktera se vénuje neméfickym kameram a zpisobim
jejich kalibrace. Dalsi kapitoly se jiz tykaly praktické ¢asti této prace. Nejprve jsme popsali
postupy a podminky, které je nutné dodrzet pti sbéru dat pozemnim laserovym skenovanim
a neméfickou kamerou za vyuziti metody SfM. Dale jsme se vénovali postupim
pfi zpracovani takto pofizenych dat, tedy tvorbé 3D modeld, v programech Agisoft
PhotoScan a Meshlab. Nakonec jsme vyhodnotili piesnost vyslednych 3D modeld
na zaklad¢ porovnani jejich objemu s analyticky vypoctenym objemem piedmétu sbéru dat

a prostfednictvim povrchovych odchylek vypoctenych programem CloudCompare.

Cil této prace jsme splnili porovnanim ptesnosti obou technik a vy¢tem vyhod a nevyhod
metod SfM neméfickou kamerou a laserového skenovani vyplyvajicich z podminek
a postupu, které je nutné dodrzet pti sbéru dat. Na zakladé zhodnoceni obou technik jsme
dospéli k zéavéru, ze laserové skenovani bychom mohli nahradit sbérem dat bézné
dostupnym hardware za vyuziti metody SfM v piipadech, kdy se pfedmét sbéru dat nachazi
v prili§ malych prostorach, dale pak pokud neni mozné pouzit laserovy skener z divodu
moznosti poSkozeni pamatky a dale také v piipad¢, kdy pozadujeme vybornou vizudlni

kvalitu vysledného 3D modelu.
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